CASE STUDY | Swan Creek National Wildlife Refuge

You have always been fascinated with wildlife in its natural habitat. For that reason, you are excited to be working with Swan Creek National Wildlife Refuge, assigned the task of promoting its educational programs to area schools and preparing documents to support the refuge’s educational outreach. The wildlife refuge is situated near a large urban area that is dominated by a thriving industry of steel production. Emily Traynom, Swan Creek’s site director, is concerned that children in the city have little opportunity to interact with nature. In fact, many spend their days indoors or on city streets, seldom having an opportunity to enjoy nature. She fears that a generation of children will mature into adults with little appreciation of the role of our country’s natural resources in the overall balance of nature. Her passion is encouraging students to visit Swan Creek and become actively involved in environmental activities.

Ms. Traynom envisions summer day camps in which children will explore the wildlife refuge and participate in learning activities. She wants to provide internships for students, encouraging an ongoing relationship with nature. For those efforts and others, you will use your expertise in Microsoft Word to produce documents such as flyers, brochures, memos, contracts, and letters. As the school year draws to a close, Ms. Traynom has asked you to design and produce an article about a series of summer camps available to children from grades 5 through 8. She has given you a rough draft of the article from which you will create an attractive document for distribution to schools and for posting on Swan Creek’s Web site.
Introduction to Word Processing

Word processing software, often called a word processor, is one of the most commonly used types of software in homes, schools, and businesses. People around the world—students, office assistants, managers, and professionals in all areas—use word processing programs such as Microsoft Word for a variety of tasks. Microsoft Word 2013, included in the Microsoft Office suite of software, is the most current version of the popular word processor. You can create letters, reports, research papers, newsletters, brochures, and all sorts of documents with Word. You can even create and send e-mail, produce Web pages, post to social media sites, and update blogs with Word. Figure 1 shows examples of documents created in Word. If a project requires collaboration online or between offices, Word makes it easy to share documents, track changes, view comments, and efficiently produce a document to which several authors can contribute. By using Word to create a research paper, you can easily create citations, a bibliography, a table of contents, a cover page, an index, and other reference pages. To enhance a document, you can change colours, add interesting styles of text, insert graphics, and use tables to present data. With emphasis on saving documents to the cloud, Word enables you to share these documents with others or access them from any device. To say the least, Word is a very comprehensive word processing solution.
Communicating through the written word is an important task for any business or organization. In fact, it would be almost impossible to conduct business without written and oral communication. Word processing software, such as Word, simplifies the technical task of preparing documents, but a word processor does not replace the writer. Be careful when wording a document so you are sure it is appropriate for the intended audience. Always remember that once you distribute a document, either on paper or electronically, you cannot retract the words. Therefore, you should never send a document that you have not carefully checked several times to be sure it conveys your message in the best way possible. Also, you cannot depend completely on a word processor to identify all spelling and grammatical errors, so be sure to closely proofread every document you create. Although several word processors, including Word, provide predesigned documents (called templates) that include basic wording for various tasks, it is ultimately up to you to compose well-worded documents. The role of business communication, including the written word, in the success or failure of a business cannot be overemphasized.

In this section, you will explore Word’s interface, learn how to create and save a document, explore the use of templates, and perform basic editing operations. You will learn how to move around in a document and to review spelling and word usage. Using Word options, you will explore ways to customize Word to suit your preferences, and you will learn to customize the Ribbon and the Quick Access Toolbar.

**Beginning and Editing a Document**

When you open Word 2013, your screen will be similar to Figure 2. You can create a blank document, or you can select from several categories of templates. Recently viewed files are shown on the left, for ease of access should you want to open any again.

To begin a blank document, click Blank document (or simply press Enter, if Blank document is selected). Word provides a clean, uncluttered area in which to type, with minimal distraction at the sides and across the top. Unlike earlier Word versions, Word 2013 provides a large, almost borderless area for your document, with an interface closely aligned with that...
of Windows 8. Using several basic features, including the Ribbon, Quick Access Toolbar, vertical and horizontal scroll bars, and the status bar, you can easily create an attractive document. Figure 3 shows a typical Word document.

The following list describes Word’s basic features in more detail:

- **Commands on the Ribbon** enable you to create, modify, and enhance documents. When you click a Ribbon tab, you can then select from various commands associated with the tab. For example, the Insert tab makes it easy to include objects such as pictures, charts, and screenshots in a document, while the Design tab focuses on document formatting and colour selections.

- The **title bar** indicates the file name of the current document and includes Windows control buttons and access to Word Help. It is also the location of the Quick Access Toolbar.

- The **Quick Access Toolbar** makes it easy to save a document, and to undo or redo recent commands.

- The **status bar** keeps you apprised of information such as word and page count, and the current position within the document.

- **View buttons** at the right side of the status bar enable you to change the view of a document, and dragging the Zoom slider enlarges or reduces the onscreen size of a document.

- Using the horizontal and vertical **scroll bars**, you can scroll through a document (although doing so does not actually move the insertion point). You will see a scroll bar only if the document is long enough and/or wide enough to require scrolling to see additional page content.
Many people enjoy having the Ribbon close at hand when developing or editing a document. Others might prefer an uncluttered workspace, free of distractions. Temporarily remove the Ribbon from view by clicking *Collapse the Ribbon* (see Figure 3). Tabs remain displayed, but all detail beneath them is hidden, resulting in a large amount of uncluttered typing space. To display the Ribbon again, click any tab and click *Pin the ribbon* (the toggle of *Collapse the Ribbon*) or simply double-click a tab on the Ribbon.

*Ribbon Display Options* (Figure 3) enables you to adjust the Ribbon view. You can choose to hide the Ribbon, providing a clear document space in which to edit or read a document. Click at the top of the Ribbon to show it again. You can also choose to show only the Ribbon tabs. Click a tab to display its options. Finally, you can choose to show all Ribbon tabs and commands, which is the default.

**Use a Template**

Wording a document can be difficult, especially if you are struck with writer's block! With that in mind, the developers of Word have included a library of *templates* from which you can select a predesigned document. You can then modify the document to suit your needs. Categories of templates are displayed when you first open Word, or when you click the File tab and click New. In addition to local templates—those that are available offline with a typical Word installation—Microsoft provides many more through Office.com. All of those templates are displayed or searchable within Word, as shown in Figure 4. Microsoft continually updates content in the template library, so you are assured of having access to all the latest templates each time you open Word.

### STEPs

**STEP 2**

**Customize the Status Bar**

You can customize the status bar to include even more items of information. Simply right-click an empty area of the status bar and select one or more items from the list.

**TIP**

Type a search term or category and search for other templates online.
Some templates are likely to become your favourites. Because you will want quick access to those templates, you can pin them to the top of the templates menu so they will always be available. Simply right-click a favourite template and click Pin to list. To unpin a previously pinned template, repeat the process but select Unpin from list.

Create a Document

To create a blank document, click Blank document when Word opens (refer to Figure 2). As you type text, you will not need to think about how much text can fit on one line or how sentences progress from one line to the next. Word’s word wrap feature automatically pushes words to the next line when you reach the right margin.

Word wrap is closely associated with another concept: the hard return and soft return. A hard return is created when you press Enter at the end of a line or paragraph. A soft return is created by Word as it wraps text from one line to the next. The locations of soft returns change automatically as text is inserted or deleted, or as page features or settings, such as objects or margins, are added or changed. Soft returns are not considered characters and cannot be deleted. However, a hard return is actually a nonprinting character, called a paragraph mark, that you can delete, if necessary. To display nonprinting characters, such as paragraph marks and tabs, click Show/Hide (¶) (see Figure 5). Just as you delete any other character by pressing Backspace or Delete (depending on whether the insertion point is positioned to the right or left of the item to remove), you can delete a paragraph mark. To remove the display of nonprinting characters, click Show/Hide (¶) again.

![Nonprinting Characters](FIGURE 5 Nonprinting Characters)

As you work with Word, you must understand that Word’s definition of a paragraph and your definition are not likely to be the same. You would probably define a paragraph as a related set of sentences, which is correct in a literary sense. When the subject or direction of thought changes, a new paragraph begins. However, Word defines a paragraph as text that ends in a hard return. Even a blank line, created by pressing Enter, is considered a paragraph. Therefore, as a Word student, you will consider every line that ends in a hard return a paragraph. When you press Enter, a paragraph mark is displayed in the document (refer to Figure 5).

In addition to the nonprinting mark that Word inserts when you press Enter, other nonprinting characters are inserted when you press keys such as Tab or the Spacebar. Click Show/Hide (¶) in the Paragraph group on the Home tab to reveal all nonprinting characters in a document (refer to Figure 5). Nonprinting characters are generally not viewed when working in a document and will not be included when a document is printed, but they can assist you with troubleshooting a document and modifying its appearance before printing or distributing.
example, if lines in a document end awkwardly, some not even extending to the right margin, you can click Show/Hide (¶) to display nonprinting characters and check for the presence of poorly placed, or perhaps unnecessary, hard returns. Deleting the hard returns might realign the document so that lines end in better fashion.

**Reuse Text**

You might find occasion to reuse text from a previously created document because the wording fits well in a document on which you are working. For example, a memo to employees describing new insurance benefits might borrow wording from another document describing the same benefits to company retirees. In that case, you would simply insert text from a saved document into the currently open memo. With the insertion point positioned where the inserted text is to be placed, complete the following steps:

1. Click the INSERT tab.
2. Click the Object arrow (see Figure 6).
3. Click Text from File.
4. Navigate to the location of the saved document and double-click the file name.

**Save a Document**

Saving a document makes it possible for you to access it later for editing, sharing, or printing. In fact, it is a good idea not to wait until a document is complete to save it, but to save a document periodically as you develop it. That way, you risk losing only what you created or edited since the last save operation if you experience a disruption of power. If you have ever worked with a word processor, you are probably familiar with the process of saving a document. Word 2013 recognizes not only the need to save files, but also the need to make them available on any device you might have access to and the need to share documents with others so you can collaborate on projects. To make that possible, Word encourages you to save documents to the cloud, or Internet, instead of a local drive, such as a hard drive or flash drive. It is always a good idea, however, to save a document in several places so that you always have a backup copy. You might save a document to a hard drive as well as SkyDrive, which is free online storage space provided by Microsoft. If you plan to use the document on another computer, you could also save it to a flash drive for ease of transporting. To save a document, click the File tab and click Save (or Save As). You can also click Save on the Quick Access Toolbar.

If you are using Windows 8 as your operating system, you most likely provided a Windows Live ID, or e-mail address, when you installed the operating system. In that case, the address connects to your associated SkyDrive storage and enables Word, and other Microsoft programs, to save files in that location by default. (A default setting is one that is automatically set unless you specify otherwise.) If you choose to share documents from your SkyDrive storage, collaborators can easily access and edit them.

As you save a file, Word enables you to select a location to save to. Although SkyDrive is the default, you can select another drive on your computer (see Figure 7).
To save a document to local storage, such as a flash drive or hard drive, click Computer (refer to Figure 7) and click Browse to navigate to the desired location. Provide a file name and either accept the default type (Word Document) or click the Save as type arrow (see Figure 8) and select another format. Users of Word 2007 and Word 2010 will be able to open a document saved in Word 2013 format, but some Word 2013 features might be disabled. However, if you plan to distribute a document to someone using a Word version earlier than Word 2007, change the type to Word 97-2003 Document. You will learn more about file compatibility later in this chapter.

To save a document to local storage, such as a flash drive, hard drive, or local network location, click Computer (refer to Figure 7) and click Browse to navigate to the desired location. Provide a file name and either accept the default type (Word Document) or click the Save as type arrow (see Figure 8) and select another format. Users of Word 2007 and Word 2010 will be able to open a document saved in Word 2013 format, but some Word 2013 features might be disabled. However, if you plan to distribute a document to someone using a Word version earlier than Word 2007, change the type to Word 97-2003 Document. You will learn more about file compatibility later in this chapter.
Open a Document

Having saved a document, you can open it later when you start Word and then either select the document from the Recent list or click Open Other Documents and navigate to the saved file. Word remembers the position of the insertion point when you previously saved the file and suggests that you return to that same location (see Figure 9). Just click the link to return, or ignore it if you prefer the current display.

FIGURE 9 Opening a Previously Viewed Document

Move Around a Document and Edit a Document

The insertion point indicates where the text you type will be inserted. It is important to remain aware of the location of the insertion point and to know how to move it so that you can control where text is typed. Probably the easiest way to move the insertion point within a document is simply to click in the desired location. When you reposition the insertion point within existing text in a document and then type text, the text is inserted between pieces of existing text.

If a document contains more text than will display onscreen at one time, you can click the horizontal or vertical scroll arrows (or drag a scroll bar) to view different parts of the document. Then, when the desired text is shown onscreen, click to position the insertion point and continue editing the document. Be aware that using the scroll bar or scroll arrows to move the display does not reposition the insertion point. It merely lets you see different parts of the document, leaving the insertion point where it was last positioned. Only when you click in the document, or use a keyboard shortcut, is the insertion point moved.

Review Word Usage in a Document

It is important to create a document that is free of typographical and grammatical errors. One of the easiest ways to lose credibility with readers is to allow such errors to occur. You will also want to choose words that are appropriate and that best convey your intentions in writing or editing a document. Word provides tools on the Review tab that simplify the tasks of reviewing a document for errors, identifying proper wording, and defining words with which you are unfamiliar.

With the automated spelling and grammar tools in Word, it is relatively easy to produce an error-free document. A word that is considered by Word to be misspelled is underlined with a red wavy line. A possible grammatical mistake or word usage error is underlined in blue. Both types of errors are shown in Figure 10. Never depend completely on Word to catch all errors; always proofread a document yourself. For example, typing the word fee when you meant to type free is not an error that Word would typically catch, because the word is not actually misspelled and might not be flagged as a word usage error, depending upon the sentence context.

To enable the Canadian dictionary in Word:
1. Click File | Options.
2. Click Language.
3. From the Add additional editing languages menu, select English (Canada).
4. Click the Add button.
5. Click the Set as Default button.
6. You will see a dialog box that reads: The new editing language you just chose will take effect the next time you start Word. Do you want to continue?
7. Click the Yes button.
8. Click the OK button.
9. You will need to restart Word for the language change to take effect.
To correct possible spelling, grammatical, or word usage errors in a document, you can right-click an underlined error and select an option from a shortcut menu. If possible, Word will attempt to provide a correction that you can select from the menu. If the word or text is not actually an error, you can choose to ignore it by making an appropriate selection from the shortcut menu.

Correcting each error by right-clicking can become time-consuming, especially if the mistakes are many. In that case, Word can check an entire document, pausing at each identified error so that you can determine whether to correct or ignore the problem. To check an entire document, click the Review tab and click Spelling & Grammar in the Proofing group (see Figure 11). For even quicker error identification, check the Proofing errors button on the status bar (see Figure 11). By default, Word will automatically check an entire open document for spelling, grammatical, and word usage errors, displaying an X on the Proofing errors button if errors are found. Click the button to either change or ignore all errors, one at a time. If, instead, you see a check mark on the Proofing errors button, the document appears to be error free. The document in Figure 11 contains errors, as indicated by the X on the Proofing errors button. Note that at a higher screen resolution than that shown in Figure 11, buttons in the Proofing group will be spelled out (Thesaurus, Define, and Word Count).
Words do not always come easily. Occasionally, you might need to find a synonym (a word with the same meaning as another) for a particular word but are unable to do so quickly. Word provides a handy thesaurus for just such an occasion. Select a word in a document and click the Review tab. Click Thesaurus (refer to Figure 11) and select from a group of synonyms. If you have installed a dictionary, you will see a definition of the selected word at the bottom of the Thesaurus pane. Otherwise, you can click a link to get a dictionary app.

**Counting Words**

Occasionally, you might need to know how many words are included in a document. For example, your English instructor might require a minimum word count for an essay. Click the Review tab and click Word Count (refer to Figure 11) to get a quick summary of words, characters, lines, pages, and paragraphs.

Especially when editing or collaborating on a document created by someone else, you might come across a word with which you are unfamiliar. After selecting a word, click the Review tab and click Define (refer to Figure 11). If a dictionary app is installed, the definition will display in the Dictionary pane.
Introduction to Word

Customizing Word

As installed, Word is immediately useful. However, you might find options that you would prefer to customize, add, or remove from the document window. For example, you can add frequently used commands to the Quick Access Toolbar for ease of access. You might prefer that the Ribbon is organized differently. These and other options are available for customization within Word.

Explore Word Options

By default, certain Word settings are determined and in place when you begin a Word document. For example, unless you specify otherwise, Word will automatically check spelling as you type. Similarly, the Mini toolbar will automatically display when text is selected. Although those and other settings are most likely what you will prefer, there may be occasions when you want to change them. When you change Word options, such as those just described, you change them for all documents—not just the currently open file. To modify Word options, click the File tab and click Options. As shown in Figure 12, you can select from several categories and then make appropriate adjustments. Word options that you change will remain in effect until you change them again, even after Word is closed and reopened. Keep in mind that if you are working in a school computer lab, you might not have permission to change options permanently.

| FIGURE 12 Word Options |

Using Apps

New to Office 2013 is an online app store, providing replacements and additions to add-ins of previous Office versions. Several are especially useful for Word, such as Britannica Researcher, Merriam-Webster Dictionary, and Pingar Summaries (preparing a document summary). Locate those apps and more when you click the Insert tab and click Apps for Office in the Apps group. Click See All and click Featured Apps to view featured apps. You can find even more at the Office Store. Click an app link and follow prompts to download it. To insert the app, click Apps for Office on the Insert tab, click See All, Click Find more apps at the Office Store, and then click Refresh. Click the app and click Insert at the bottom of the dialog box.

STEP 5

Using Apps

New to Office 2013 is an online app store, providing replacements and additions to add-ins of previous Office versions. Several are especially useful for Word, such as Britannica Researcher, Merriam-Webster Dictionary, and Pingar Summaries (preparing a document summary). Locate those apps and more when you click the Insert tab and click Apps for Office in the Apps group. Click See All and click Featured Apps to view featured apps. You can find even more at the Office Store. Click an app link and follow prompts to download it. To insert the app, click Apps for Office on the Insert tab, click See All, Click Find more apps at the Office Store, and then click Refresh. Click the app and click Insert at the bottom of the dialog box.

Customizing Word

As installed, Word is immediately useful. However, you might find options that you would prefer to customize, add, or remove from the document window. For example, you can add frequently used commands to the Quick Access Toolbar for ease of access. You might prefer that the Ribbon is organized differently. These and other options are available for customization within Word.

Explore Word Options

By default, certain Word settings are determined and in place when you begin a Word document. For example, unless you specify otherwise, Word will automatically check spelling as you type. Similarly, the Mini toolbar will automatically display when text is selected. Although those and other settings are most likely what you will prefer, there may be occasions when you want to change them. When you change Word options, such as those just described, you change them for all documents—not just the currently open file. To modify Word options, click the File tab and click Options. As shown in Figure 12, you can select from several categories and then make appropriate adjustments. Word options that you change will remain in effect until you change them again, even after Word is closed and reopened. Keep in mind that if you are working in a school computer lab, you might not have permission to change options permanently.

| FIGURE 12 Word Options |
Customize the Ribbon

The Word 2013 Ribbon provides access to commands that make it easy to develop, edit, save, share, and print documents. If necessary, you can add and remove Ribbon tabs, as well as rename them. Simply click the File tab and click Options. Click Customize Ribbon. By deselecting a tab name (see Figure 13), you can remove a Ribbon tab. Later, you can select it again to redisplay it. Click a tab name and click Rename to change the name of the tab. Type a new name and press Enter. To return to showing all original tabs, click Reset and click Reset all customizations.

Customize the Quick Access Toolbar

The Quick Access Toolbar (QAT) contains only a few commands, by default. With one click, you can save a document. Another QAT command enables you to undo a recent command, whereas another is the Redo command. Although it is helpful to have those options close at hand, you might want to include even more on the QAT. You can even remove commands that you do not use often. To customize the QAT, click Customize Quick Access Toolbar (see Figure 14) and select from a menu of options (or click More Commands for even more choices). You can also add a Ribbon command when you right-click it and select Add to Quick Access Toolbar. To remove a command from the QAT, right-click the command on the QAT and select Remove from Quick Access Toolbar.
1. When creating or editing a document, you can show nonprinting characters. In what ways might the display of nonprinting characters assist you with developing a document?

2. Word 2013 strongly encourages saving documents to a SkyDrive account. In fact, SkyDrive is the default save location. Provide at least two advantages of using SkyDrive as a storage location for your documents.

3. It is very important to check a document for spelling, grammatical, and word usage errors—a task that Word 2013 can help you with. However, Word 2013 might not identify every error in a document. Why not? Provide an example of an error that Word might not identify.

4. In your position of employment, you must print documents often. Describe a way to customize Word to minimize the number of steps required to print a document.
Hands-On Exercise 1

Introduction to Word Processing

As an office assistant working with the wildlife refuge, you will prepare a document publicizing the summer day camps at Swan Creek. Your supervisor has worded a few paragraphs that you will modify and add to, creating an article for distribution to schools in the area. You will also open a document from a template, creating a calendar. Because you plan to use the office computer for future projects as well, you will explore ways to customize Word for ease of use.

Skills covered: Create and Save a Document • Use a Template • Move Around a Document and Edit a Document • Review Word Usage in a Document • Explore Word Options • Customize the Ribbon • Customize the Quick Access Toolbar

STEP 1 ➔ CREATE AND SAVE A DOCUMENT

As you create a new document, you will insert text provided by your supervisor at the wildlife refuge and then save the document for later editing. Refer to Figure 15 as you complete Step 1.

a. Open Word. Click Blank document. Click Save on the Quick Access Toolbar. In the right pane, click the location where you save your files and change the file name to w01h1Refuge_LastFirst. Click Save.

When you save files, use your last and first names. For example, as the Word author, I would name my document w01h1Refuge_HoganLynn.

b. Click the INSERT tab and click the Object arrow. Click Text from File. Navigate to w01h1Camps.docx in the location of your student data files and double-click the file name. Press Ctrl+Home to move the insertion point to the beginning of the document.

c. Click Save on the Quick Access Toolbar.

This saves the document with the same name and in the same location as the previous save.

d. Click the FILE tab and click Close to close the document.

You will use this document again later in this Hands-On Exercise.

e. Click Close to exit Word.
STEP 2 USE A TEMPLATE

As a multitasker, you are accustomed to working with several projects at once. Ms. Traynom, your supervisor, has asked that you print a calendar for the current year. She often must plan ahead and needs an at-a-glance calendar showing each month. You know that Word provides calendar templates, so you will locate one. Refer to Figure 16 as you complete Step 2.

![Calendar Template]

**TROUBLESHOOTING:** The calendar template is only available if you are currently connected to the Internet.

a. Open Word. Click the Search for online templates box and type Calendar. Press Enter. Click Year-at-a-Glance in the Filter by pane on the right. Scroll through the calendar templates presented and click to select one that presents the current year.

b. Click Create. Save the calendar as w01h1Calendar_LastFirst.

   The location of your student files should display in the Recent Folders list on the right side of the Save As window. Click to select the location.

c. Click Close to exit Word.

STEP 3 MOVE AROUND A DOCUMENT AND EDIT A DOCUMENT

Although Ms. Traynom provided you with a good start, you will add a bit more detail to the w01h1Refuge_LastFirst article. Refer to Figure 17 as you complete Step 3.
a. Open Word. In the Recent list, click w01h1Refuge_LastFirst.

b. Click the HOME tab, if necessary, and click Show/Hide (¶) in the Paragraph group, if necessary, to display nonprinting formatting marks.

c. Click after the sentence ending in finest?—immediately after the question mark at the end of the fourth sentence in the body text—and press Enter to insert a hard return. Press Delete to remove the space before the word Swan.

**TROUBLESHOOTING:** There will be no space before Swan if you clicked after the space instead of before it when you pressed Enter. In that case, there is no space to delete, so leave the text as is.

d. Scroll down and click after the word Creek!—immediately after the exclamation point after the second body paragraph—and press Enter to insert a hard return.

e. Type the following text, pressing Enter at the end of each line:

- explore nature
- learn to identify native plants and wildlife
- take digital photos
- participate in nature seminars
- enjoy relaxing days at the refuge

As you type each line, the first letter is automatically capitalized. Unless you specify otherwise in Word Options, words that begin new paragraphs and sentences are capitalized. In this case, the capitalization is correct, so leave the words as they are capitalized by Word.

f. Press Ctrl+End. Press Delete to delete the final paragraph mark in the document.
**STEP 4** REVIEW WORD USAGE IN A DOCUMENT

As you continue to develop the article, you will check for spelling, grammar, and word usage mistakes. You will also identify a synonym and get a definition. Refer to Figure 18 as you complete Step 4.

**Step d:** Define

**Step e:** Thesaurus

**Step f:** Close the pane

**Step b:** Select the correct option, if necessary

**Step b:** Click Change to apply the correction

**FIGURE 18 Reviewing the Document**

a. Press Ctrl+Home to move to the beginning of the document. Right-click the red underlined word native in the second line of the first body paragraph in the document. Click native on the shortcut menu to select the correct spelling.

b. Click the REVIEW tab and click Spelling & Grammar in the Proofing group. As each error is presented, click to select the correct option. The word it's should not include an apostrophe, so ensure the correct option is selected (see Figure 18) and click Change. The word fo should be for. Click OK when the check is complete.

c. At least one error in the document is not identified as a spelling or word usage error by Word. Read through the document to identify and correct the error.

d. Drag to select the word immersed in the first sentence of the first body paragraph (or double-click the word to select it). Click Define in the Proofing group. If a dictionary app is installed, you should see a definition of the word in the pane on the right. If a dictionary app is not installed, follow the prompts to install a dictionary app.

e. Close the pane on the right. With the word immersed still selected, click Thesaurus in the Proofing group. Point to the word absorbed, click the arrow at the right, and then select Insert.

f. Close the Thesaurus pane. Save the document.

**STEP 5** EXPLORE WORD OPTIONS

You will explore some Word options that will enable you to customize the computer assigned to you at the refuge. Such customization ensures that Word is configured to suit your preferences. Refer to Figure 19 as you complete Step 5.
Hands-On Exercise 1

a. Click the FILE tab and click Options. Ensure that the General category in the left pane is selected. Note that you can change the User name and Initials that identify you as the author of documents you create. Because you might be working in a computer lab, you will not actually change anything at this time.

b. Click Save in the left pane of the Word Options dialog box. Note that you can adjust the AutoRecover time, a feature covered later in this chapter, by typing in the text box, replacing existing text, or by clicking the up or down arrow repeatedly.

c. Click Cancel, so you do not actually make changes.

STEP 6 ›› CUSTOMIZE THE RIBBON

As you continue to explore ways to customize Word preferences, you will identify Ribbon tabs that you can add or remove. Refer to Figure 20 as you complete Step 6.

FIGURE 20 Customizing the Ribbon
a. Click the FILE tab and click Options. Click Customize Ribbon in the left pane. Under Main Tabs, click the Mailings check box to deselect the item.

**TROUBLESHOOTING:** If Mailings is not deselected, you clicked the word Mailings instead of the check box next to it. Click the Mailings check box.

b. Click Review under Main Tabs (click the word Review, not the check mark beside the word). Click Rename (located beneath the list of Main Tabs) and type Review Document—but do not click OK.

c. Click Cancel, so that changes to the Ribbon are not saved to a lab computer. Click Cancel again.

**STEP 7  CUSTOMIZE THE QUICK ACCESS TOOLBAR**

You will customize the Quick Access Toolbar to include commands that you use often. Refer to Figure 21 as you complete Step 7.

![Figure 21 Customizing the Quick Access Toolbar](image)

a. Click Customize Quick Access Toolbar, located at the right side of the QAT, and select Print Preview and Print from the shortcut menu.

As shown in Figure 21, an additional button appears on the QAT, enabling you to preview and print a document when you click the button.

b. Click the REVIEW tab, if necessary, and right-click Spelling & Grammar in the Proofing group. Click Add to Quick Access Toolbar.

c. Right-click the Print Preview and Print button on the Quick Access Toolbar and select Remove from Quick Access Toolbar.

d. Repeat the process to remove Spelling & Grammar from the Quick Access Toolbar.

e. Save the document. Keep the document open if you plan to continue with the next Hands-On Exercise. If not, close the document and exit Word.
Document Organization

Most often, the reason for creating a document is for others to read; therefore, the document should be designed to meet the needs of the reading audience. It should not only be well worded and structured, but also might include features that better identify it, such as headers, footers, and watermarks. A watermark is text or graphics that display behind text. In addition, adjusting margins and changing page orientation might better suit a document’s purposes and improve its readability. Depending on its purpose, a document might need to fit on one page, or it could be very lengthy.

Before printing or saving a document, you will want to review it to ensure that it is attractive and appropriately organized. Word has various views, including Read Mode, Print Layout, Web Layout, Outline, and Draft, that you can use to get a good feel for the way the entire document looks in a variety of uses, regardless of its length. The view selected can also give a snapshot of overall document organization so you can be assured that the document is well structured and makes all points. In this section, you will explore features that improve readability, and you will learn to change the view of a document.

Using Features That Improve Readability

Choosing your words carefully will result in a well-worded document. However, no matter how well worded, a document that is not organized in an attractive manner so that it is easy to read and understand is not likely to impress the audience. Consider not only the content, but also how a document will look when printed or displayed. Special features that can improve readability, such as headers, footers, and symbols, are located on Word’s Insert tab. Other settings, such as margins, page orientation, and paper size, are found on the Page Layout tab. The Design tab provides access to watermarks, which can help convey the purpose or originator of a document.

Insert Headers and Footers

*Headers* and *footers* can give a professional appearance to a document. A header consists of one or more lines at the top of each page. A footer displays at the bottom of each page. One advantage of using headers and footers is that you have to specify the content only once, after which it displays automatically on all pages. Although you can type the text yourself at the top or bottom of every page, it is time-consuming, and the possibility of making a mistake is great. Typically, the purpose of including a header or footer is to better identify the document. As a header, you might include an organization name or a class number so that each page identifies the document’s origin or purpose. A page number is a typical footer, although it could just as easily be included as a header.

To insert a header or footer, click the Insert tab and click Header (or Footer) in the Header & Footer group. Select from a gallery of predefined header or footer styles or click Edit Header (or Edit Footer), as shown in Figure 22, to create an unformatted header or footer. After typing a header or footer, click Close Header and Footer to leave the header and footer area and return to the document (see Figure 23). In Print Layout view, you can also double-click in the document to close the header or footer. A header or footer can be formatted like any other text. It can be centre-, left-, or right-aligned, and formatted in any font or font size. When working with a header or footer, the main body text of the document is greyed out temporarily. When you return to the document, the body text is active, but the header or footer text is dim.
Word provides fields, such as author, date, and file name, that you can choose to include in headers and footers. Some header and footer fields, such as page numbers, will actually change from one page to the next. Other fields, such as author name and date, will remain constant. Regardless, selecting fields (instead of typing the actual data) simplifies the task of creating headers and footers. Some of the most frequently accessed fields, such as Date & Time and Page Number, are available on the Header & Footer Tools Design contextual tab as separate commands (see Figure 24). Others, including Author, File Name, and Document Title, are available when you click Document Info in the Insert group. Depending on the field selected, you might have to indicate a specific format and/or placement. For example, you could display the date as Monday, August 12, 2016, or you might direct that a page number is centred.

Word provides fields, such as author, date, and file name, that you can choose to include in headers and footers. Some header and footer fields, such as page numbers, will actually change from one page to the next. Other fields, such as author name and date, will remain constant. Regardless, selecting fields (instead of typing the actual data) simplifies the task of creating headers and footers. Some of the most frequently accessed fields, such as Date & Time and Page Number, are available on the Header & Footer Tools Design contextual tab as separate commands (see Figure 24). Others, including Author, File Name, and Document Title, are available when you click Document Info in the Insert group. Depending on the field selected, you might have to indicate a specific format and/or placement. For example, you could display the date as Monday, August 12, 2016, or you might direct that a page number is centred.

Word provides fields, such as author, date, and file name, that you can choose to include in headers and footers. Some header and footer fields, such as page numbers, will actually change from one page to the next. Other fields, such as author name and date, will remain constant. Regardless, selecting fields (instead of typing the actual data) simplifies the task of creating headers and footers. Some of the most frequently accessed fields, such as Date & Time and Page Number, are available on the Header & Footer Tools Design contextual tab as separate commands (see Figure 24). Others, including Author, File Name, and Document Title, are available when you click Document Info in the Insert group. Depending on the field selected, you might have to indicate a specific format and/or placement. For example, you could display the date as Monday, August 12, 2016, or you might direct that a page number is centred.

Word provides fields, such as author, date, and file name, that you can choose to include in headers and footers. Some header and footer fields, such as page numbers, will actually change from one page to the next. Other fields, such as author name and date, will remain constant. Regardless, selecting fields (instead of typing the actual data) simplifies the task of creating headers and footers. Some of the most frequently accessed fields, such as Date & Time and Page Number, are available on the Header & Footer Tools Design contextual tab as separate commands (see Figure 24). Others, including Author, File Name, and Document Title, are available when you click Document Info in the Insert group. Depending on the field selected, you might have to indicate a specific format and/or placement. For example, you could display the date as Monday, August 12, 2016, or you might direct that a page number is centred.

Occasionally, you will want a header or footer on all pages except the first, such as when the first page is a report’s cover page. In that case, select Different First Page in the Options group on the Header & Footer Tools Design tab (when a header or footer is selected).
You will find that you use some fields more often than others as headers and footers. Word 2013 provides one-click access to common fields such as Author, File Name, File Path, and Document Title when you click Document Info in the Insert group on the Header & Footer Tools Design tab. You can click Field for a complete list of fields to choose from (see Figure 25). The same fields are available when you click Quick Parts in the Insert group and click Field.

![Figure 25: Inserting Fields](image)

**Insert a Symbol**

A *symbol* is text, a graphic, or a foreign language character that can be inserted into a document. Most symbols are not located on the keyboard and are available only from Word’s collection of symbols. Symbols such as © and ™ can be an integral part of a document; in fact, those particular symbols are necessary to properly acknowledge a source or product. Because they are typically not located on the keyboard, you need to find them in Word’s library of symbols or use a shortcut key combination, if available.

Some symbols serve a very practical purpose. For example, it is unlikely you will want a hyphenated word to be divided between lines in a document. In that case, instead of typing a simple hyphen between words, you can insert a *nonbreaking hyphen*, which is available as a symbol. Similarly, you can insert a *nonbreaking space* when you do not want words divided between lines. For example, a person’s first name on one line followed by the last name on the next line is not a very attractive placement. Instead, make the space between the words a nonbreaking space by inserting the symbol, so the names are never divided. Select a non-breaking hyphen, nonbreaking space, and other special characters when you click the Insert tab, Symbol, More Symbols, and Special Characters. Click a special character and click Insert to place it in a document.

A typical Microsoft Office installation includes a wide variety of fonts. To view and select a symbol, click the Insert tab and click Symbol. A gallery of frequently accessed symbols displays, from which you can choose. If the symbol you seek is not in the list, click More Symbols. Figure 26 shows the dialog box from which you can search for a symbol. Depending upon the font selected (normal text is shown in Figure 26), your symbol choices will vary. Fonts such as Wingdings, Webdings, and Symbol contain a wealth of special symbols, many of which are actually pictures.
Each symbol is assigned a character code. If you know the character code, you can type the code (refer to Figure 26) instead of searching for the symbol itself or using a keyboard shortcut.

Adjust Margins

A margin is the area of blank space that displays to the left, right, top, and bottom of a document, between the text and the edge of the page. Although a 2.54 cm (1") margin all around the document is the normal setting, you can easily adjust one or more margins for a particular document. You might adjust margins for several reasons. You can change a document’s appearance and readability, perhaps even causing it to fit attractively on one page, by adjusting margins. Also, a style manual, such as you might use in an English class, will require certain margins for the preparation of papers and publications.

You can change margins in a couple of ways:

- Click the PAGE LAYOUT tab and click Margins in the Page Setup group. Select from one of the predefined margin settings (see Figure 27) or click Custom Margins to adjust each margin (left, right, top, and bottom) individually.
- Click the FILE tab and click Print. Click Normal Margins (or the previous margin setting) to change one or more margins.

Using Symbol Shortcuts

You can insert some symbols, such as ©, ™, and ℗, as keyboard shortcuts. For example, type (c) to insert ©, (tm) for ™, and :) for ℗.

Every symbol is assigned a character code. If you know the character code, you can type the code (refer to Figure 26) instead of searching for the symbol itself or using a keyboard shortcut.

Word figures in this Canadian edition reflect metric units of measurement, and metric equivalents have been added to all instructions. To choose metric as a preference in Word:
1. Click File | Options.
2. From the navigation menu at the left, click Advanced.
3. Scroll down to Display and change Show measurements in units of to Centimetres.
Change Page Orientation

You will find that some documents are more attractive in either portrait or landscape orientation. A document displayed in portrait orientation is taller than it is wide, whereas a document shown in landscape is wider than it is tall. Most certificates are designed in landscape orientation; letters and memos are typically presented in portrait orientation. You can change page orientation in several ways:

- Click Orientation on the PAGE LAYOUT tab to select either Portrait or Landscape.
- Click Margins on the PAGE LAYOUT tab and click Custom Margins to display the Page Setup dialog box (see Figure 28). From there, select either Portrait or Landscape.
- Click the FILE tab, click Print, and then click Portrait Orientation (or Landscape Orientation if the document is in landscape orientation). Select either Portrait Orientation or Landscape Orientation.

FIGURE 27 Adjusting Margins

FIGURE 28 Selecting Page Orientation
Insert a Watermark

A watermark, which is text or graphics that displays behind text on a page, is often used to display a very light, washed-out logo for a company or to indicate the status of a document. For example, a watermark displaying Draft indicates that the document is not in final form. The document shown in Figure 29 contains a watermark. Watermarks do not display on a document that is saved as a Web page, nor will they display in Word’s Web Layout view (discussed later in this chapter). To insert a watermark, click the Design tab and click Watermark. Select from predesigned styles, or click Custom Watermark to create your own. To remove a previously created watermark (for example, when a draft becomes final), click the Design tab, click Watermark, and then select Remove Watermark.

FIGURE 29 Inserting a Watermark

[Image of a document with a watermark that says “Draft”]

Formatting a Watermark

In selecting a custom watermark (click the Design tab, click Watermark, and then select Custom Watermark), you can select or change a watermark’s colour, size, font, and text. In addition, you can include a picture as a watermark.

Viewing a Document in Different Ways

Developing a document is a creative process. As you create, edit, or review a project, you will want to view the document in various ways. Word provides a view that enables you to see a document as it will print, as well as views that maximize typing space by removing page features. You might like to review a document in a magazine-type format for ease of reading, or perhaps a hierarchical view of headings and subheadings would help you better understand and proof the structure of a document. The ability to zoom in on text and objects can make a document easier to proofread, while viewing a document page by page helps you manage page flow—perhaps drawing attention to awkward page endings or beginnings. Taking advantage of the various views and view settings in Word, you will find it easy to create attractive, well-worded, and error-free documents.
Select a Document View

When you begin a new document, you will see the top, bottom, left, and right margins. The document view is called **Print Layout view**, and it is the default view. You can choose to view a document differently, which is something you might do if you are at a different step in its production. For example, as you type or edit a document, you might prefer **Draft view**, which provides the most typing space possible without regard to margins and special page features. Word’s **Read Mode** facilitates proofreading and comprehension, whereas **Outline view** displays a document in hierarchical fashion, clearly delineating levels of heading detail. If a document is destined for the Web, you would want to view it in **Web Layout view**.

To change document view, click the View tab and select a view from the Views group (see Figure 30). Although slightly more limited in choice, the status bar also provides views to choose from (Read Mode, Print Layout, and Web Layout). Word views are summarized in Table 1.

![Choose a View](image)

**FIGURE 30 Changing Word View**

<table>
<thead>
<tr>
<th>View</th>
<th>Appearance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Mode</td>
<td>Primarily used for reading, with a document shown in pages, much like a magazine. The Ribbon is hidden, with only a limited number of menu selections shown.</td>
</tr>
<tr>
<td>Print Layout</td>
<td>Shows margins, headers, footers, graphics, and other page features—much like a document will look when printed.</td>
</tr>
<tr>
<td>Web Layout</td>
<td>Shows a document as it would appear on a Web page.</td>
</tr>
<tr>
<td>Outline</td>
<td>Shows level of organization and detail. You can collapse or expand detail to show only what is necessary. Often used as a springboard for a table of contents or a PowerPoint summary.</td>
</tr>
<tr>
<td>Draft</td>
<td>Provides the most space possible for typing. It does not show margins, headers, or other features, but it does include the Ribbon.</td>
</tr>
</tbody>
</table>
The Read Mode is new to Word 2013. Designed to make a document easy to read and to facilitate access across multiple devices, Read Mode presents a document in a left to right flow, automatically splitting text into columns, if necessary, for a magazine-like appearance. Text often displays in a two-page format. Text adjusts to fit any size screen, flowing easily from page to page with a simple flick of a finger (if using a tablet or touch-sensitive device) or click of the mouse. Users of touch-based devices can rotate the device between landscape and portrait modes, with the screen always divided into equally sized columns. When in Read Mode (see Figure 31), you will note that the Ribbon is removed from view. Instead, you have access to only three menu items: File, Tools, and View. One of the most exciting features of Read Mode is object zooming. Simply double-click an object, such as a table, chart, picture, or video, to zoom in. Press Esc to leave Read Mode. Although you can also leave Read Mode when you click the View tab and click Edit Document, doing so causes subsequently opened Word documents to automatically display in Read Mode when opened.

**FIGURE 31 Using Read Mode**

A key element to understanding the history of the capital cities of the Northwest Territories is to recognize that the region’s varied and often rocky development started with Canada buying the Territories from the Hudson’s Bay Company in 1869. The Northwest Territories are quite uniquely placed among some of the other provinces in that the Territories had seven capital cities in their history. For several reasons, the Territories have had the seat of government changed a number of times but especially because of civil conflict, problems with the development of appropriate infrastructure, and a long history of major restructuring and revisions to their territorial boundaries.

The results of these changes have led to difficult and complicated government changes, which have threatened the concept of a responsible government. It is important for the government to be

**TIP** Working with Words in Read Mode

In Read Mode, right-click a word and choose Define from the shortcut menu for a quick definition and synonym. Select Translate, if the document is not in your native language.
Change the Zoom Setting

Regardless of the view selected, you can use Word’s zoom feature to enlarge or reduce the view of text. Unlike zooming in on an object in Read Mode, the zoom feature available on the View tab enables you to enlarge text, not objects or videos. Enlarging text might make a document easier to read and proofread. However, changing the size of text onscreen does not actually change the font size of a document. Zooming in or out is simply a temporary change to the way a document appears onscreen. The View tab includes options that change the onscreen size of a document (see Figure 32). You can also enlarge or reduce the view of text by dragging the Zoom slider on the status bar. Click Zoom In and Zoom Out on the status bar to change the view incrementally by 10% for each click.

Use the Zoom command on the View tab to select a percentage of zoom or to indicate a preset width (page width, text width, or whole page). Preset widths are also available as individual options in the Zoom group on the View tab (refer to Figure 32).

View a Document and Manage Page Flow

Document lengths can vary greatly. A research paper might span 20 pages, whereas a memo is seldom more than a few pages (most often, only one). Obviously, it is easier to view a memo onscreen than an entire research paper. Even so, Word enables you to get a good feel for the way a document will look when printed or distributed, regardless of document length.

Before printing, it is a good idea to view a document in its entirety. One way to do that is to click the File tab and click Print. A document is shown one page at a time in print preview (see Figure 33). Click the Next Page or Previous Page navigation arrow to proceed forward or backward in pages. You can also view a document by using options on the View tab (refer to Figure 32). Clicking One Page provides a snapshot of the current page, while Multiple Pages shows pages of a multiple-page document side by side (and on separate rows, in the case of more than two pages).
Occasionally, a page will end poorly—perhaps with a heading shown alone at the bottom of a page or with a paragraph split awkwardly between pages. Or perhaps it is necessary to begin a new page after a table of contents, so that other pages follow in the order they should. In those cases, you must manage page flow by forcing a page break where it would not normally occur. Simply click where the page break is to be placed and do one of the following:

- Press Ctrl+Enter.
- Click the PAGE LAYOUT tab, click Breaks, and then select Page.

With nonprinting characters shown, you will see the Page Break designation (see Figure 34). To remove the page break, click the Page Break indicator and press Delete.
1. Some header and footer items, such as author name and file name, serve to identify the document and its origin. Other header and footer fields portray data that changes. Provide at least two examples of fields that contain variable data. When would you want to exclude headers and footers from the first page of a document, and how would you do that?

2. A watermark is often in the form of text, such as the word *Draft*, which indicates that a document is not in its final form. What other text and/or graphic watermarks might you include in a document?

3. The status bar includes selections that change a document view. Compare and contrast the view selections on the status bar.

4. You have just completed a multiple-page research paper, including a cover page. Before printing the paper, you will check it onscreen to determine how text flows from one page to the next, assuring attractive page endings (no heading shown alone at the end of a page, for example). Provide two ways to view the multiple-page document, so that at least one entire page is shown at a time. Also, assume that you find it necessary to break a page before a solo heading at the bottom of a page. How would you force a page break at that location?
2 Document Organization

You are almost ready to submit a draft of the summer day camp article to your supervisor for approval. After inserting a footer to identify the document as originating with the U.S. Fish and Wildlife Service, you will adjust the margins and determine the best page orientation for the document. Next, you will insert a watermark to indicate it is a draft document. Finally, you will review the document for overall appearance and page flow.

Skills covered: Insert Headers and Footers • Adjust Margins • Change Page Orientation • Insert a Watermark • Insert a Symbol and Select a Document View • View a Document, Change the Zoom Setting, and Manage Page Flow

STEP 1 » INSERT HEADERS AND FOOTERS

You will insert a footer to identify the article as a publication of the U.S. Fish and Wildlife Service. The footer will also include the file name. Refer to Figure 35 as you complete Step 1.

a. Open w01h1Refuge_LastFirst if you closed it at the end of Hands-On Exercise 1 and save it as w01h2Refuge_LastFirst, changing h1 to h2.

Troubleshooting: If you make any major mistakes in this exercise, you can close the file, open w01h1Refuge_LastFirst again, and then start this exercise over.

b. Click the INSERT tab, click Footer in the Header & Footer group, and then select Edit Footer. Type U.S. Fish and Wildlife Service. Press Enter.
STEP 2 ›› ADJUST MARGINS

The article fits on one page, but you anticipate adding text. You suspect that with narrower margins, you might be able to add text while making sure the article requires only one page. You will experiment with a few margin settings. Refer to Figure 36 as you complete Step 2.

a. Click the PAGE LAYOUT tab, click Margins in the Page Setup group, and then select Narrow.

At a glance, you determine the right and left margins are too narrow, so you will adjust them.

b. Click Margins and select Custom Margins. Adjust the Left and Right margins to 1” (2.54 cm) and click OK.

c. Click the VIEW tab and click One Page in the Zoom group.

The document appears to be well positioned on the page, with what appears to be room for a small amount of additional text, if necessary.

d. Save the document.
Hands-On Exercise 2

a. Click **100%** in the Zoom group on the VIEW tab.

b. Make sure nonprinting characters display. If they do not, click **Show/Hide (¶)** in the Paragraph group on the Home tab.

c. Triple-click in the second body paragraph, beginning with *Swan Creek National Wildlife Refuge is offering*, to select the entire paragraph and press **Delete** to remove the paragraph.

d. Delete the single line paragraphs near the end of the document, beginning with *Explore nature* and ending with *Enjoy relaxing days at the refuge*.

e. Click the **FILE tab** and click **Save As**. Because the document is a shortened version of the original, you will save it with a different name. Save the file as **w01h2Flyer_LastFirst**.

Given the shortened nature of the document, you will see whether landscape orientation provides a more attractive view.

f. Click the **PAGE LAYOUT tab** and click **Orientation** in the Page Setup group. Click **Landscape**. Click the **VIEW tab**, and click **One Page**. The new orientation is not attractive, so click **Undo** on the Quick Access Toolbar.

The flyer is attractive, but you do not think it requires a footer. You will remove the footer.

g. Scroll down and double-click in the footer area. Select both footer lines and press **Delete** to remove the footer. Double-click in the document to close the footer.

h. Click the **FILE tab** and click **Print** to confirm the footer is removed.

i. Click **Save** in the left pane to save the document. Click the **FILE tab** and click **Close** to close the flyer without exiting Word.
**STEP 4 ›› INSERT A WATERMARK**

You will open the original article so that you can add the finishing touches, making sure to identify it as a draft and not the final copy. To do so, you will insert a DRAFT watermark, which can be removed after your supervisor has approved the document for distribution. Refer to Figure 38 as you complete Step 4.

**a.** Click the FILE tab and click w01h2Refuge_LastFirst in the list of recent documents.

**b.** Click the DESIGN tab and click Watermark in the Page Background group. Scroll through the gallery of watermarks and click DRAFT 1 (under Disclaimers).

The watermark is not as visible as you would like, so you will change the colour.

**c.** Click Watermark again and select Custom Watermark. Click the Color arrow in the Printed Watermark dialog box and click Red (under Standard Colors). Click OK.

**d.** Save the document.

---

**FIGURE 38 Adding a Watermark**

---

**STEP 5 ›› INSERT A SYMBOL AND SELECT A DOCUMENT VIEW**

The article you are preparing will be placed in numerous public venues, primarily schools. Given the widespread distribution of the document, you must consider any legality, such as appropriate recognition of name brands or proprietary mentions by inserting a trademark symbol. You will also ensure that words flow as they should, with no awkward or unintended breaks between words that should remain together. Refer to Figure 39 as you complete Step 5.

---

**Hands-On Exercise 2**
Hands-On Exercise 2

a. Click after the word June on the second line in the second body paragraph. Make sure you have placed the insertion point before the space following the word June. Press Delete to remove the space. Regardless of where the line ends, you want to make sure the phrase June 15 is not separated, with the month on one line and the day on the following line. Therefore, you will insert a nonbreaking space.

b. Click the INSERT tab and click Symbol in the Symbols group. Click More Symbols. Click the Special Characters tab. Click Nonbreaking Space. Click Insert and click Close.

c. Click after the word Striker in the last sentence of the same paragraph. Click Symbol in the Symbols group and click More Symbols. Click Special Characters. Click Trademark to insert the Trademark symbol. Click Insert and click Close. You use the Trademark symbol to indicate that Striker is a brand name.

d. Click the VIEW tab and click Draft in the Views group. Click Print Layout in the Views group.

e. Save the document.

**STEP 6 ›› VIEW A DOCUMENT, CHANGE THE ZOOM SETTING, AND MANAGE PAGE FLOW**

Ms. Traynom has provided you with a cover letter to include with the article. You will incorporate the letter text into the article as the first page, remove the footer from the first page, proofread the document, and ensure that both pages are attractively designed. Refer to Figure 40 as you complete Step 6.
Hands-On Exercise 2

a. Press `Ctrl+Home` to position the insertion point at the top of the article. Press `Ctrl+Enter` to insert a blank page at the top. Press `Ctrl+Home` to move to the top of the new page. Note that both the watermark and the footer display on the new page. That is because those features are designed to appear by default on all pages of a document.

b. Click the **INSERT** tab, if necessary, and click the **Object arrow** in the Text group. Click **Text from File**. Navigate to `w01h2Letter` in your student data files and double-click the file name.

c. Double-click in the footer area of the first page. Click **Different First Page** in the Options group of the **HEADER & FOOTER TOOLS DESIGN** tab.

You have indicated that the watermark and footer are not to appear on the first page, but will remain on all others.

d. Click **Close Header and Footer** in the Close group.

e. Press `Ctrl+Home`. Click the **VIEW** tab and click **Zoom** in the Zoom group. Click in the **Percent box** and change the Zoom to 125%. Click **OK**.

f. Scroll through the document, proofreading for spelling and grammatical errors. Right-click any underlined error and either correct or ignore it. Manually correct any errors that Word has not flagged.

g. Click **Multiple Pages** in the Zoom group.

h. Click the **FILE** tab and click **Print**. Click **Next Page** (the arrow that follows 1 of 2 at the bottom of the screen) to view the article. Click **Previous Page** to return to the letter.

The letter appears to be too high on the page, so you will move the text down a bit.

i. Click **Back** (the arrow at the top left) to return to the document. Click 100% in the Zoom group. Press `Ctrl+Home` to move to the top of the document. Press `Enter` three times to move the text down the page.

j. Click the **FILE** tab and click **Print**. The first page should be better situated on the page, with additional space at the top.

k. Save the document. Keep the document open if you plan to continue with the next Hands-On Exercise. If not, close the document and exit Word.
Document Settings and Properties

After you organize your document and make all the formatting changes you desire, you need to save the document in its final form and prepare it for use by others. You can take advantage of features in Word that enable you to manipulate the file in a variety of ways, such as identifying features that are not compatible with older versions of Word, saving in a format that is compatible with older versions, and including information about the file that does not display in the document. For example, you can include an author name, a subject, and even keywords—all information that does not display in the content of the document but further identifies the file, and can be used as a basis on which to search for or categorize the document later. Because you are well aware of the importance of saving files, and even making backup copies of those files, you will explore backup options.

In this section, you will explore ways to prepare a document for distribution, including saving in a format compatible with earlier versions of Word, converting a file created in an earlier version to Office 2013, checking for sensitive information included in a file, making backup copies of important documents, and working with print options. In addition, you will learn to customize and print document properties.

Preparing a Document for Distribution

Seldom will you prepare a document that you do not intend to distribute. Whether it is a report to submit to your instructor or a memo on which you collaborated, most likely the document is something that will be shared with others. Regardless of how you plan to develop, save, and distribute a document, you will not want to chance losing your work because you did not save it properly or failed to make a backup copy. Inevitably, files are lost, systems crash, and viruses infect a system. That said, the importance of saving work frequently and ensuring that backup copies exist cannot be overemphasized.

With the frequency of new Word versions, there is always a chance that someone who needs to read your document is working with a version that is not compatible with yours, or perhaps the person is not working with Word at all. You can eliminate that source of frustration by saving a document in a compatible format before distributing it. Another source of concern when distributing a document is the hidden or personal data that might be stored in document properties, such as the author's or organization's name. Backing up documents, ensuring their compatibility with other software versions, and removing document information that is either unnecessary or has the potential for too much disclosure should definitely be considered before finalizing a project or allowing others to see it.

Ensure Document Compatibility

Earlier in this chapter, in the section on saving files, you learned how to save a document in an earlier Word version so that someone without access to Word 2013 might still open the file. You might also consider saving a file in Rich Text Format, which adds even more flexibility, as such a file can be opened by other word processing software in addition to Word. Be aware, however, that doing so might compromise the document somewhat because Rich Text Format, and even earlier Word versions, cannot accommodate all of the current Word version's special features. (See the section in this chapter on saving a file for information on how to change the file type.)

When you open a file created in an earlier Word version, the words Compatibility Mode are included in the title bar, advising you that some of Word 2013’s features will not be available or viewable in the document. While in Compatibility Mode, you might not be able to use new and enhanced features of the most current Word version; by keeping the file in Compatibility Mode, you ensure that people with earlier Word versions will still have full
editing capability when they receive the document. However, if you want to convert the file to Office 2013, complete the following steps:

1. Click the FILE tab. Info should be selected; if not, click to select it.
2. Click Convert (beside Compatibility Mode). The Convert option will not be displayed if the file is currently in Office 2013 format.
3. Click OK.

When you convert a file, you change the original file to a newer version of Word. When you subsequently save the file, it is saved in the newest Word version.

Documents saved in Word 2013 can be opened by users of Word 2010 and Word 2007. Even so, documents developed in Word 2013 might contain features that are not recognizable by those or earlier versions. In some cases, it might be necessary for a user of Word 2007 or Word 2010 to install a service pack or otherwise download a software solution in order to view a Word 2013 file in its entirety.

Before distributing a document, you can check it for compatibility, ensuring that it can be read in its entirety by users of earlier Word versions. To check a document for compatibility, do the following:

1. Click the FILE tab.
2. Click Check for Issues (beside Inspect Document).
3. Click Check Compatibility.
4. Click Select versions to show and then select one or more versions of Word to check (or simply leave them all selected).
5. After reading a summary of any features that are incompatible, click OK.

Understand Backup Options

Word enables you to back up files in different ways. One option is to use a feature called AutoRecover. If Word crashes when AutoRecover is enabled, the program will be able to recover a previous version of your document when you restart the program. The only work you will lose is anything you did between the time of the last AutoRecover operation and the time of the crash, unless you happen to save the document in the meantime. By default, file information is saved every 10 minutes (see Figure 41), but you can adjust the setting so that the AutoRecover process occurs more or less frequently.
You can also configure Word to create a backup copy each time a document is saved. Although the setting to always create a backup copy is not enabled by default, you can enable it from Word Options in the Advanced category. Scroll through categories under Advanced options to locate the Save group, in which you can choose to always create a backup copy. Word will create a backup copy in this way. Assume that you have created the simple document with the phrase *The fox jumped over the fence*, and have saved it under the name *Fox*. Assume further that you edit the document to read *The quick brown fox jumped over the fence*, and that you save it a second time. The second Save command changes the name of the original document (containing the text *The fox jumped over the fence*) from *Fox* to *Backup of Fox*, then saves the current contents (*The quick brown fox jumped over the fence*) as *Fox*. In other words, the disk now contains two instances of the document: the current *Fox* document and the document containing the original text—*Backup of Fox*.

The cycle goes on indefinitely, with *Fox* always containing the current document and *Backup of Fox* the most recent instance. So, if you revise and save the document a third time, the original wording of the document is no longer available, because only two instances of the document are kept. The contents of *Fox* and *Backup of Fox* are different, but the existence of the latter enables you to retrieve the previous iteration if you inadvertently edit beyond repair or accidentally erase the current *Fox* document. To enable an automatic backup:

**STEP 2**
1. Click the FILE tab.
2. Click Options.
3. Click Advanced.
4. Scroll to the Save group and click *Always create backup copy*. Click OK.

**Run the Document Inspector**

Before you send or give a document to another person, you should run the Document Inspector to reveal any hidden or personal data in the file. For privacy or security reasons, you might want to remove certain items contained in the document such as author name, comments made by one or more persons who have access to the document, or document server locations. Word's Document Inspector will check for and enable you to remove various types of identifying information, including:

- Comments, revisions, versions, and annotations
- Document properties and personal information
- Custom XML data
- Headers, footers, and watermarks
- Invisible content
- Hidden text

Because some information removed by the Document Inspector cannot be recovered with the Undo command, you should save a copy of your original document, using a different name, prior to inspecting the document. To inspect a document:

**STEP 3**
1. Click the FILE tab.
2. Click Check for Issues.
3. Click Inspect Document.
4. If a dialog box appears, click Yes if you have not yet saved the file and want to do so (or click No if you have already saved the file).
5. The Document Inspector dialog box (see Figure 42) enables you to confirm the types of content you want to check. Deselect any categories you do not want to check.
6. Click Inspect to begin the process. When the check is complete, Word lists the results and enables you to choose whether to remove the content from the document. For example, if you are distributing a document to others, you might want to remove all document properties and personal information. In that case, you can instruct the Document Inspector to remove such content.
Select Print Options

It is far too easy to print an entire document when you intend to print only a few pages. That is because you might not pay enough attention to print options, one of which enables you to print the entire document unless you specify otherwise. You will find that print setting, and others, when you click the File tab and click Print. The current printer is shown, although you can change to another installed printer, if you like (see Figure 43). The Print settings shown in Figure 43 enable you to select the number of copies, the pages or range of pages to print, the printer to use, whether to collate pages, whether to print on only one side of the paper, and how many pages to print per sheet. In addition, you can adjust page orientation, paper size, and even customize a document's margins—all by paying attention to print options. Please note that the wording of some Print options will vary, depending on whether you have previously selected the option and indicated a custom setting. For example, if you recently selected Print All Pages and indicated a specific range to print, then the Print All Pages option will display the most recent range of pages printed or selected.
Print options display to the left of the document preview (refer to Figure 43). You can click the Next Page or Previous Page navigation arrow to move among pages in the document preview. You can also drag the Zoom slider to enlarge or reduce the size of the document preview.

**Modifying Document Properties**

Occasionally, you might want to include information to identify a document, such as author, document purpose, intended audience, or general comments. Those data elements, or *metadata*, are saved with the document, but do not appear in the document as it displays onscreen or is printed. Instead, you can use the **Document Panel** to display descriptive information. You can even search for a file based on identifying information you assign a document. For example, suppose you apply a keyword of CIS 225 to all documents you create that are associated with that particular college class. Later, you can use that keyword as a search term, locating all associated documents.

For statistical information related to the current document, click the File tab and make sure that Info is selected. Data such as file size, number of pages, and total words are presented (see Figure 44). You can modify some document information in this view, such as adding a title or comments, but for more possibilities, display the full Document Panel (see Figure 45). To display the Document Panel:

1. Click the FILE tab.
2. Click the Properties arrow.
3. Click Show Document Panel.

![FIGURE 44 Opening the Document Panel](image)

![FIGURE 45 Viewing the Document Panel](image)
When you save the document, Word saves this information with the document. You can update the descriptive information at any time by opening the Document Panel for the respective document.

Customize Document Properties

In addition to creating, modifying, and viewing a document summary, you may want to customize document properties in the Document Panel. For example, you might want to add a Date completed property and specify an exact date for reference. This date would reflect the completion date, not the date the file was last saved. You also might create a field to track company information such as warehouse location or product numbers.

To customize document properties:

STEP 4

1. Click the FILE tab and click Info, if necessary. Click Properties and click Advanced Properties. The Properties dialog box displays, showing commonly used properties on the General tab.
2. Click the Custom tab of the Properties dialog box to add custom property categories and assign values to them.
3. Click Add, after assigning a value to a custom category, and click OK.

Checking Statistics

When working with Advanced Properties, you might want to check document statistics, such as the date the document was created, the total editing time, or the word count. Click the File tab, select Info, and then click Properties. Click Advanced Properties and click the Statistics tab to view statistics related to the current document.

Print Document Properties

You can print document properties to store hard copies for easy reference. To do this:

1. Click the FILE tab.
2. Click Print.
3. Click Print All Pages.
4. Click Document Info.
5. Click Print.

Quick Concepts

1. A coworker who uses Office 2007 has sent you a document for review. When you open the document, the words [Compatibility Mode] display in the title bar after the file name. Is there any reason you might want to remove the document from Compatibility Mode? And if so, how would you convert the document to Word 2013 format?
2. You are aware that it is very important to create backup copies of important documents. Describe the process of using Word 2013 options to ensure that backup copies are automatically created.
3. Before distributing a document, you want to make sure any personally identifying information, such as author and comments, are removed. How would you accomplish that?
4. Before printing pages 3 through 5 of the current document, you want to preview the document and then print only those pages. In a separate print procedure, you also want to print document properties that are associated with the current document. What steps would you follow to preview and print those pages?
3 Document Settings and Properties

As the office assistant for Swan Creek National Wildlife Refuge, you are responsible for the security, management, and backup of the organization’s documents. The article promoting the summer day camps is ready for final approval. Before that happens, however, you want to check it one last time yourself, making sure it is saved in a format that others can read and that you have sufficient backup copies. You will also include appropriate document properties for additional identification, and you will consider print options. Privacy and security are to be considered as well, so you will check for identifiers that should be removed before distributing the document.

Skills covered: Ensure Document Compatibility • Understand Backup Options • Run the Document Inspector and Select Print Options • Customize and Print Document Properties

STEP 1 ›› ENSURE DOCUMENT COMPATIBILITY

You know Ms. Traynom is anxious to review a copy of this document; however, she has not yet upgraded to Office 2013. Instead, her office computer has Office 2007 installed. To make sure she can open and read the document, you will check the document for compatibility with earlier Word versions. Refer to Figure 46 as you complete Step 1.

**FIGURE 46 Converted Document**

---

Hands-On Exercise 3
a. Open w01h2Refuge_LastFirst if you closed it at the end of Hands-On Exercise 2 and save it as w01h3Refuge_LastFirst, changing h2 to h3.

b. Click the FILE tab, make sure that Info is selected, and then click Check for Issues (beside Inspect Document).

c. Click Check Compatibility. Click Select versions to show and deselect Word 97-2003 to make sure only Word 2007 and Word 2010 are selected.

Note that some formatting features are not supported and will not be available in the version you are preparing for Ms. Traynom.

d. Click OK. Save the document.

Because the compatibility issues are few and are restricted to what appear to be minor text effects, you feel confident that Ms. Traynom will be able to open the document in Word 2007. You will also provide her with a printed copy, just in case.

e. Click the FILE tab and close the document.

The personnel director has prepared a draft of a memo introducing a new employee. He has asked that you proof the document and prepare it for printing. However, he created and saved the memo using Word 2007. You will open the file and convert it to Word 2013 format.

f. Open w01h3NewEmployee from your data files.

The title bar displays [Compatibility Mode] following the file name w01h3NewEmployee, indicating that it is not a file saved with Word 2013.

g. Click the FILE tab and click Convert (beside Compatibility Mode). A message box displays explaining the consequences of upgrading the document. Click OK.

The Compatibility Mode designation is removed from the title bar.

h. Save the document as w01h3NewEmployee_LastFirst.

---

**STEP 2 UNDERSTAND BACKUP OPTIONS**

The timeline for preparing for the summer day camps is short. Given the time spent in developing the article, you know that if it were lost, recreating it in a timely fashion would be difficult. In fact, it is critical to ensure appropriate backups for all files for which you are responsible at Swan Creek. You will explore backup options on your computer to verify that files are saved periodically and that backups are automatically created. Refer to Figure 47 as you complete Step 2.

---

**FIGURE 47 Checking AutoRecover Time**

[Image of AutoRecover setting dialog box]
a. Click the FILE tab and click Options. Click Save in the left pane of the Word Options dialog box. If Save AutoRecover information every is checked, note the number of minutes between saves.

b. Click Advanced. Scroll to the Save area and note whether Always create backup copy is selected.

You will not select the setting at this time, although you should consider doing so on your own computer or a computer at a workplace.

c. Click Cancel. Close the document.

**STEP 3 ›› RUN THE DOCUMENT INSPECTOR AND SELECT PRINT OPTIONS**

Before distributing the article, you will run the Document Inspector to identify any information that should first be removed. You will also prepare to print the document. Refer to Figure 48 as you complete Step 3.

![Figure 48: Selecting Print Settings](image)

**FIGURE 48 Selecting Print Settings**

Step d: Select pages to print

Step e: Indicate number of copies

Step c: Previous Page

Step c: Next Page

a. Open w01h3Refuge_LastFirst. Click the FILE tab and click Check for Issues (beside Inspect Document). Click Inspect Document. Click Inspect.

You check for document areas that might display sensitive information. The inspection suggests that the category of Document Properties and Personal Information contains identifying data, as does that of Headers, Footers, and Watermarks. You determine that it would be best to remove all document properties, but you will leave headers, footers, and watermarks.

b. Click Remove All beside Document Properties and Personal Information. Click Close.

c. Click Print. Click Next Page to view the next page. Click Previous Page to return to the first page.

d. Click Print All Pages, click Custom Print, and then type 2 in the Pages box.

You indicate that you want to print page 2 only.
Hands-On Exercise 3

**e.** Click the **Copies up arrow** repeatedly to print five copies.

You have indicated that you want to print five copies of page 2.

**f.** Press **Esc** to return to the document without printing.

### STEP 4  CUSTOMIZE AND PRINT DOCUMENT PROPERTIES

You will assign document properties to the document to identify its author and purpose. You will also create an additional property to record a project identifier. Finally, you will prepare to print document properties. Refer to Figure 49 as you complete Step 4.

**a.** Save the document as `w01h4Refuge_LastFirst`, changing `h3` to `h4`. Click the **FILE tab**, click **Properties** in the right pane, and then click **Show Document Panel**.

The Document Panel displays above your document.

**b.** Ensure that the **Author box** contains your name. Type your name, if necessary. Click one time in the **Comments box** and type **Summer Camp Information**.

**c.** Click the **Document Properties arrow** in the top left of the Document Properties panel and click **Advanced Properties** to display the `w01h4Refuge_LastFirst Properties` dialog box.

**d.** Create a custom property by completing the following steps:

- Click the **Custom tab** and select **Project** in the **Name list**.
- Type **School Information** in the **Value box**, as shown in Figure 56, and click **Add**.
- Click **OK** to close the dialog box.

You want to catalogue the documents you create for Swan Creek National Wildlife Refuge, and one way to do that is to assign a project scope using the custom properties that are stored with each document. Because you set up a custom field in the Document Properties, you can later perform searches and find all documents in that Project category.

**e.** Click **Close the Document Information Panel** in the top-right corner of Document Properties. Save the document.

**f.** Click the **FILE tab**, click **Print**, click **Custom Print**, and then click **Document Info**. If your computer is in communication with, or connected to, a printer, click **Print**. Otherwise, continue to step **g**.

**g.** Save and close `w01h4Refuge_LastFirst` and submit based on your instructor’s directions.
Chapter Objectives Review

After reading this chapter, you have accomplished the following objectives:

1. **Begin and edit a document.**
   - Use a template: Predesigned documents save time by providing a starting point.
   - Create a document: Create a blank document by clicking *Blank document* when Word opens.
   - Save a document: Saving a document makes it possible to access it later for editing, sharing, or printing.
   - Open a document: Open a saved document by selecting the document from the Recent Documents List or browsing for other documents.
   - Move around a document and edit a document: Use scroll bars or keyboard shortcuts to move around in a document.
   - Review Word usage in a document: Use the Review tab to make sure all documents are free of typographical and grammatical errors.

2. **Customize Word.**
   - Explore Word options: Word options are global settings you can select, such as whether to check spelling automatically, or where to save a file by default.
   - Customize the Ribbon: Customize the Ribbon, using Word Options, to add, remove, or rename Ribbon tabs.
   - Customize the Quick Access Toolbar: The Quick Access Toolbar contains a few commands by default, but you can add more when you click *Customize the Quick Access Toolbar* and select from a menu.

3. **Use features that improve readability.**
   - Insert headers and footers: Headers and footers provide information, such as page number and organization name, in the top and bottom margins of a document.
   - Insert a symbol: A symbol is typically a character or graphic that is not found on the keyboard, such as ©.
   - Adjust margins: You can change margins, selecting predefined settings or creating your own.
   - Change page orientation: Select Landscape (located on the Page Layout tab) to show a document that is wider than it is tall, or Portrait to show a document taller than it is wide.
   - Insert a watermark: A watermark is text or a graphic that displays behind text to identify such items as a document's purpose, owner, or status.

4. **View a document in different ways.**
   - Select a document view: A view is the way a document displays onscreen; available Word views include Print Layout, Read Mode, Outline, Web Layout, and Draft.
   - Change the zoom setting: By changing the zoom setting (available on the View tab as well as the status bar), you can enlarge or reduce text size onscreen.
   - View a document and manage page flow: Forcing a page break is useful to divide document sections (for example, to separate a cover page from other report pages), or to better manage page flow so that pages do not end awkwardly.

5. **Prepare a document for distribution.**
   - Ensure document compatibility: Using Word 2013, you can convert documents to the most recent version and you can also ensure a document's compatibility with earlier versions.
   - Understand backup options: Backup options include AutoRecover and the ability to always create a backup copy of a saved document.
   - Run the Document Inspector: Word's Document Inspector reveals any hidden or personal data in a file and enables you to remove sensitive information.
   - Select print options: Using Word's print options (available when you click the File tab and click Print), you can specify the pages to print, the number of copies, and various other print selections.

6. **Modify document properties.**
   - Customize document properties: Document properties are items you can add to a document to further describe it, such as author, keywords, and comments.
   - Print document properties: For documentation purposes, you might want to print Document Properties.
Key Terms Matching

Match the key terms with their definitions. Write the key term letter by the appropriate numbered definition.

a. AutoRecover  
b. Document Inspector  
c. Document Panel  
d. Draft view  
e. Header and Footer  
f. Insertion point  
g. Landscape orientation  
h. Microsoft Word  
i. Outline view  
j. Portrait orientation  
k. Print Layout view  
l. Quick Access Toolbar  
m. Read Mode  
n. Ribbon  
o. Symbol  
p. Template  
q. Watermark  
r. Word processing software  
s. Word wrap

1. _______ The long bar of tabs, groups, and commands located just beneath the Title bar.
2. _______ Text or graphic that displays behind text.
3. _______ A structural view of a document or presentation that can be collapsed or expanded as necessary.
4. _______ Area that provides one-click access to commonly used commands.
5. _______ Document that is displayed taller than it is wide.
6. _______ The feature that automatically moves words to the next line if they do not fit on the current line.
7. _______ Enables Word to recover a previous version of a document.
8. _______ A computer application, such as Microsoft Word, used primarily with text to create, edit, and format documents.
9. _______ View in which text reflows to screen-sized pages to make it easier to read.
10. _______ Word processing application included in the Microsoft Office software suite.
11. _______ A predesigned document that may include format and wording that can be modified.
12. _______ Document that is displayed wider than it is tall.
13. _______ View that closely resembles the way a document will look when printed.
14. _______ A character or graphic not normally included on a keyboard.
15. _______ Checks for and removes certain hidden and personal information from a document.
16. _______ Information that displays at the top or bottom of each document page.
17. _______ View that shows a great deal of document space, but no margins, headers, footers, or other special features.
18. _______ Blinking bar that indicates where text that you next type will appear.
19. _______ Provides descriptive information about a document, such as a title, subject, author, keywords, and comments.
Multiple Choice

1. The view that presents a document in screen-sized pages with two shown at a time, for ease of comprehension and sharing, is the:
   (a) Read Mode.
   (b) Print Layout view.
   (c) Draft view.
   (d) Full Screen Mode.

2. One reason to display nonprinting characters is to:
   (a) Simplify the process of converting a document to an earlier Word version.
   (b) Enable spell-checking on the document.
   (c) Enable document properties to be added to a document.
   (d) Assist with troubleshooting a document and modifying its appearance.

3. You are the only person in your office to upgrade to Word 2013. Before you share documents with coworkers, you should do which of the following?
   (a) Print out a backup copy.
   (b) Run the Compatibility Checker.
   (c) Burn all documents to CD.
   (d) Have no concerns that coworkers can open your documents.

4. Word 2013 encourages saving files so they can be accessed from multiple devices. One way that is accomplished is by:
   (a) Creating an automatic backup copy of every file, regardless of where it is saved.
   (b) Saving to your SkyDrive account.
   (c) Shortening the AutoRecover interval so save operations occur more frequently and in various locations.
   (d) Saving all files to flash storage by default, so files can then be transferred to other devices.

5. Which of the following is detected by the contextual spelling check feature?
   (a) Incorrectly divided words that flow from one line to the next
   (b) Use of the word their when you should use there
   (c) Irregular capitalization
   (d) Improper use of commas

6. Suppose you are preparing a report that requires a cover page followed by text on the next page. To keep the cover page on its own page, you would position the insertion point at the end of the cover page and do which of the following?
   (a) Press Enter.
   (b) Click the PAGE LAYOUT tab, click Breaks, and then select Line Numbers.
   (c) Press Ctrl+Enter.
   (d) Press Ctrl+Page Down.

7. You need to prepare a resume to assist in your job search but are challenged with the design of the document. You have a classic case of writer’s block! Word provides assistance in the form of a predesigned document called a:
   (a) Template.
   (b) Pattern.
   (c) Document Inspector.
   (d) Shell.

8. You have just opened a document provided by a coworker, and the title bar includes not only the file name but also the words Compatibility Mode. What does that mean?
   (a) The file was created in an earlier version of Word but saved as a Word 2013 file.
   (b) The file was created using another operating system, but opened under a version of Windows.
   (c) Word 2013 has placed the document in read-only mode, which means you will not be able to edit it.
   (d) The file was created in an earlier version of Word and might not be able to accommodate newer Word 2013 features unless you convert it.

9. To identify a document as a draft, and not in final form, which of the following could you add to the document?
   (a) Symbol
   (b) Watermark
   (c) Template
   (d) Document property

10. You plan to print only the current page of a Word document. Instead, the entire document prints. What should you have done to print only one page?
    (a) Click Print on the PRINT LAYOUT tab and click Current Page.
    (b) Click Print on the Quick Access Toolbar.
    (c) Click Print on the FILE tab and change the print setting to print only the current page.
    (d) Click Info on the FILE tab and change the print document property to only the current page.
You are a student assistant in your college’s Career Placement Centre (CPC). The CPC provides assistance with job searches, hosts job fairs on campus, collects student resumés for inclusion in departmental “resumé yearbooks,” and encourages many other forms of college-to-career activities. The newest project is the preparation of a guidebook for students who are nearing graduation or are otherwise seeking a career track. You are charged with the task of modifying a description of interview skills that was actually included in an earlier guidebook. The only problem is that the document was saved in Word 2007 format, so you must make sure it is converted to the most current Word version before beginning to modify it (in case you want to include any special features of the newest version). This exercise follows the same set of skills as used in Hands-On Exercises 1–3 in the chapter. Refer to Figure 50 as you complete this exercise.

a. Open the w01p1Interview document. The words [Compatibility Mode] inform you the document was created in an earlier version of Word.

b. Click the FILE tab, and then click Save As. Save the document as w01p1Interview_LastFirst. Click Save. You will be presented with a dialog box letting you know the document will be upgraded to the newest file format. Click OK.

c. Press Ctrl+Home to make sure the insertion point is at the beginning of the document and check the document for errors:

- Click the REVIEW tab and click Spelling & Grammar in the Proofing group. The university’s name is Athabasca, so it is not misspelled. Click Ignore All.
- Correct any other identified errors, if they are actually incorrect.
- Read over the document again, checking for errors the spell-check might have missed.
d. Double-click to select the word *ongoing* in the paragraph that begins with *We know you are serious* and click *Define* in the Proofing group to get a definition. If a definition does not display, you might not have a dictionary app installed. Follow the prompts to install a dictionary. Close the Define pane on the right. Click *Thesaurus* in the Proofing group to get an alternative word for *ongoing*. Locate the word *current* in the Thesaurus pane, click its arrow, and then click *Insert*. Close the Thesaurus pane.

e. Make the following edits in the document:

- Remove the words *if possible* (including the following comma and space) from the paragraph following the *Do your homework* heading by selecting the text and pressing *Delete*.
- Begin the same sentence with the capitalized word *Visit*.
- Rearrange the words *first practising* in the Practise paragraph, so they read *practising first*.

f. Select the hyphen between the words *midriff* and *showing* in the *Dress for success* paragraph. Click the *INSERT* tab and click *Symbol* in the Symbols group. Click *More Symbols*. Click the *Special Characters* tab. Click *Nonbreaking Hyphen*. Click *Insert* and click *Close*. You have made sure the words will not be divided between lines. Select the double “hyphen” between the words *confident* and *which* in the Practise paragraph. Following the same steps, insert an em dash. Close the Symbols dialog box.

g. Click the *DESIGN* tab and click *Watermark* in the Page Background group. Scroll through the watermarks and click *Draft 2*. Click *Watermark*, click *Custom Watermark*, and then deselect *Semitransparent*. Click *Color*, select *Red*, *Accent 2*, and then click *OK*. You have inserted a watermark that indicates the document is not yet final.

h. Set up a footer:

- Click the *INSERT* tab and click *Footer* in the Header & Footer group.
- Click *Edit Footer*. Type *Career Placement Centre* and press Enter.
- Click *Document Info* on the Header & Footer Tools Design tab and select *File Name*.
- Click *Close Header and Footer* (or double-click in the body of the document).

i. Because the document will be bound in a notebook, you will make the left margin larger:

- Click the *PAGE LAYOUT* tab and click *Margins* in the Page Setup Group.
- Click *Custom Margins*.
- Change the left margin to 5.08 cm (2”) and click *OK*.
- Click the *VIEW* tab and click *Multiple Pages* in the Zoom group to see how the text is lining up on the pages.

j. Because the *Practise* paragraph is split between two pages, you will insert a page break before the paragraph heading:

- Click before the *Practise* heading. If nonprinting characters are not displayed, click the *HOME* tab and click *Show/Hide* (¶).
- Press Ctrl+Enter to insert a page break.

k. Press Ctrl+Home. Click the *VIEW* tab and click *Read Mode* in the Views group. Click the arrow on the right to move from one page to the next. Press Esc to return to the previous document view.

l. Save the document. Before distributing the document, you will check it for sensitive information:

- Click the *FILE* tab and click *Check for Issues*.
- Click *Inspect Document* and click *Inspect*.
- Click *Remove All* beside *Document Properties and Personal Information*. Click *Close*.

m. Finally, you will check the document for compatibility with earlier Word versions:

- Click *Check for Issues* and click *Check Compatibility*.
- Click *Select versions to show* and make sure that all earlier Word versions are selected. Click *Select versions to show again* to close the list. One compatibility issue is found.
- Click *OK*.

n. Click Save on the Quick Access Toolbar to save the document. It is saved as a Word 2013 file. One of your coworkers is still using Word 2003, so you will also save the document in that format:

- Click the *FILE* tab and click *Save As*.
• Click the location where you save your files in the Recent Folders list (or click Computer and navigate to the location).
• Click the Save as type box and click Word 97-2003 Document. Click Continue.
• Click Save. Although the file name remains the same, you have actually saved two files in this step. One is named w01p1Interview_LastFirst.docx (the Word 2013 version), and the other is called w01p1Interview_LastFirst.doc (the Word 97-2003 version).

o. Close the file and submit based on your instructor’s directions.

2 Aztec Computers

As the co-owner of Aztec Computers, you are frequently asked to provide information about computer viruses and backup procedures. You are quick to tell anyone who asks about data loss that it is not a question of if it will happen, but when—hard drives fail, removable disks are lost, and viruses may infect systems. You advise customers and friends alike that they can prepare for the inevitable by creating an adequate backup before the problem occurs. Because people appreciate a document to refer to about this information, you have started one that contains information that should be taken seriously. After a few finishing touches, you will feel comfortable about passing it out to people who have questions about this topic. This exercise follows the same set of skills as used in Hands-On Exercises 1–3 in the chapter. Refer to Figure 51 as you complete this exercise.

FIGURE 51 Multiple Pages View

a. Open w01p2Virus and save it as w01p2Virus_LastFirst.
b. Press Ctrl+Enter to insert a page break, creating a blank page at the beginning. Press Ctrl+Home to move the insertion point to the beginning of the first page.
c. You will insert a short paragraph prepared by your partner, promoting the company and encouraging the use of computer security tools. The paragraph will be shown on a page by itself, as a lead-in to the article. To insert the paragraph:
   • Click the INSERT tab and click the Object arrow in the Text group.
   • Click Text from File.
   • Locate and click w01p2Summary and click Insert.
d. Press Ctrl+Home. You want to add a heading above the paragraph, so type Aztec Computers. Press Enter. Type Your Total Computer Solution. Press Enter twice.
e. Scroll to the bottom of the second page and click before the title *The Essence of Backup*. Click the PAGE LAYOUT tab, click Breaks in the Page Setup group, and then click Page. Click the VIEW tab and click Multiple Pages in the Zoom group. Scroll to view all pages. Click 100% in the Zoom group.

f. You will add a footer to better identify the document:
   - Click the INSERT tab and click Footer in the Header & Footer group.
   - Click Edit Footer.
   - Click Page Number in the Header & Footer group, point to Current Position, and then click Plain Number. You have created a page number footer.

g. Scroll to the top of the current page and click in the Header area. Type your first name and last name. Double-click in the document to close the header.

h. Click the FILE tab and click Print. Click Previous Page to view the previous page. Click Back (the arrow at the top left) to return to the document.

i. If nonprinting characters are not displayed, click the HOME tab and click Show/Hide (¶). You will make edits to the text:
   - The second to last sentence in the first body paragraph on page 2 should begin with the word Unusual instead of Usual. Make that change.
   - Click before the paragraph mark after the word worm in the second body paragraph. Delete the paragraph mark so the two paragraphs become one.
   - Locate the words will it in the last paragraph on the second page (in the sentence beginning with *If you are prone to think this way*). Reverse those words so the sentence reads it will instead of will it.

j. Press Ctrl+Home. Click the REVIEW tab and click Spelling & Grammar in the Proofing group. Correct any identified errors, if they are actual errors. The word Trojan should be capitalized and backup should be two words, in the context in which it is presented. Click OK when the spelling check is complete.

k. Press Ctrl+Home. Click the VIEW tab and click Read Mode in the Views group. Move to the second page and double-click the graphic. Click the arrow at the top-right corner of the graphic to enlarge it. Press Esc. Press Esc again to return to Print Layout view.

l. Click the PAGE LAYOUT tab, click Margins in the Page Setup group, and then select Custom Margins. Change the left and right margins to 1.90 cm (0.75”). Click Landscape and click OK. Because the document is adjusted to landscape orientation, the newly created left and right margins (1.90 cm/0.75”) are now considered the top and bottom margins.

m. Click the FILE tab and click Print. Click Next Page and/or Previous Page repeatedly to view all pages. You decide portrait orientation is a better choice for this document. Click Landscape Orientation and click Portrait Orientation.

n. Click Info, click Properties, and then click Show Document Panel. Click in the Comments box and type General information for understanding computer viruses. Click Close the Document Information Panel (on the top-right side of the Document Panel).

o. Save the document. Click the FILE tab, click Check for Issues, and then click Check Compatibility. There are no compatibility issues with earlier Word versions, so click OK.

p. Click the FILE tab, click Check for Issues, click Inspect Document, click No, and then click Inspect. Click Close after you review the results.

q. Click Print. Click Print All Pages, click Custom Print, and then type 2-3 to indicate that you want to print only the second and third pages. Because you are likely in a lab setting, you will not print the pages.

r. Press Esc twice to return to the document. Save and close the file, and submit based on your instructor’s directions.
Mid-Level Exercises

1 Runners at Heart

CREATIVE CASE

A local cross-country team, Runners at Heart, is comprised of people who are recovering from a heart ailment or who support the cause of fitness for former heart patients. A half marathon is coming up in five months, and the Runners at Heart cross-country team wants to be prepared. A half marathon is a run/walk of 21 kilometres (13 miles). You and others have researched tips on preparing for a half marathon. You have begun a document containing a few of those tips, and will collect ideas from other club members as well. You will finalize the tips document and make it available in plenty of time for the runners to prepare.

a. Open w01m1Running and save it as w01m1Running_LastFirst.

b. Move to the end of the document and press Enter. Insert the text from w01m1Tips, a list of running tips provided by another club member.

c. Make sure nonprinting characters display. View each page of the document and note that the first page ends awkwardly, with a single heading at the bottom. Insert a page break before the Prepare mentally heading.

d. The headings from the w01m1Tips file should be capitalized to be consistent with those you typed earlier. Make that correction. They should read: Train with Others, Do Your Research, Rest, What to Wear, and Prepare Mentally.

e. Insert a hard return before each heading except Prepare Mentally (beginning with Choose a Plan and ending with What to Wear) to increase the space between them. Make sure you are in Print Layout view. Because the page break is no longer necessary in its current position, click on the Page Break line and press Delete. Insert a hard return before the Prepare Mentally heading.

f. View the document and insert a page break, if necessary, wherever a heading stands alone.

g. Identify synonyms for the word regimen in the Choose a Plan section. Insert the word routine. Check for spelling and word usage errors, correcting any that are identified. The brand of clothing is correctly spelled Dri-Fit. Proofread the document carefully to identify any errors that Word might have missed.

h. Insert a page number footer as a Plain Number in the current position (on the left side of the footer). As a header, include the file name as a field.

i. Select the hyphen between the words long and distance in the paragraph following Training Tips for a Half Marathon. Insert a nonbreaking hyphen. Insert a trademark symbol immediately after the words Nike Dri-Fit in the What to Wear paragraph.

j. Add a custom watermark, with a text or graphic of your choice. The watermark should be clearly visible, and coloured, if you like.

k. Change the page orientation to landscape. Preview the document to determine if the orientation is appropriate. Return to the document and delete the page break before the Rest heading. Remove one of the blank paragraphs before the Rest heading.

l. Save the document. Because one of your club members, who will contribute to the document later, uses Word 2003, save the document in that format, with the same file name. Click Continue if warned of unsupported features. Save it again as a Word 2013 file by changing the file type (during the save operation) to Word Document. Agree to replace the existing file and click OK. Click OK when advised that the file will be upgraded to the newest format.

m. Open the Document Panel and replace the current author with your first and last names. In the Comments section, type Tips for a Half Marathon. Close the Document Panel.

n. Preview the document and then remove the watermark. Print the document properties if approved by your instructor.

o. Save and close the file, and submit based on your instructor’s directions.
Health Fair

You are a pediatric health assistant in a pediatrician’s office. The local community college is hosting a health fair and has asked that your office staff a table promoting childhood vaccinations. Having worked in the office for several years, you are well aware of the benefits of immunization against a host of serious illnesses, so you are happy to help. You want to prepare a document summarizing in an at-a-glance fashion the advantages of immunization and the problems with avoiding it. However, because you are not a physician, you will depend on the doctor you work with to provide a bit of research and statistics that you will then compile into a more complete document for distribution.

a. Open w01m2Vaccines and save it as w01m2Vaccines_LastFirst.
b. Preview the document to get a feel for the text flow.
c. Check for spelling and word usage errors. Proofread the document to identify and correct errors that Word might have missed. (Hint: Most, but not all, vaccines have a low risk of side effects.)
d. Remove the words as well from the last sentence in the second body paragraph. The sentence should end with child, so you should also remove the comma and space before the words as well. Remove the word actually from the last sentence of the third body paragraph. In the same paragraph, click before the word Vaccines in the sentence beginning Vaccines contain a weak form. Insert a hard return.
e. Identify a synonym for the word counteracted in the third sentence of the third body paragraph. Replace the word with thwarted. Your document is limited to 500 words. Check the status bar for a word count (or click Word Count in the Proofing group) to see if you are above or below the limit.
f. Select the hyphen between the words day and a in the third body paragraph. Replace the selection with an em dash symbol.
g. Select the word Vaccines anywhere in the document and use Word’s Translate Language tool to identify the equivalent word in Spanish. You do not need to make the change in the document.
h. Change all margins to 1.90 cm (0.75”). Preview the document.
i. Include the file name in the footer area. On a separate line in the footer, type your first name and last name.
j. View each page of the document and make any adjustments necessary to ensure that only two pages are included, with the required vaccinations shown on the second page.
k. Add a watermark with the text Health Fair shown in red. The watermark should be horizontal. Save the document.
l. List yourself as the author in Document Properties. The subject is Childhood Vaccinations.
m. Run the Compatibility Checker to make sure the file is compatible with earlier Word versions.
n. Save and close the file, and submit based on your instructor’s directions.

College Events

You and a group of your fellow students are assigned the project of preparing a document describing several upcoming events at your college or university. Identify a few events to highlight, and assign each event to a student. Although each student will conduct independent research on an event, all event descriptions will be collected and combined into one document for submission to your instructor. To complete the project:

a. Identify a unique name for the group (perhaps assigned by your instructor).
b. Identify events (perhaps conduct research online) and assign one event to each student.
c. Each student will collect information on the event (general description, location, cost, etc.).
d. Compose a cover letter to the instructor, identifying group members and noting events to be included in the document. The cover letter should be attractive and error-free.
e. Insert a hard return at the end of the cover letter so that the first event description begins on a new page.
f. Save the document to SkyDrive as **w01m3Events_GroupName** (replacing **GroupName** with the actual group name). Go to [http://skydrive.live.com](http://skydrive.live.com), sign in, and then open **w01b3EventsGroupName**. Click **Share** and click **Get link**. Click **Shorten** to get a shorter version of the URL. Provide the URL to group members so each member can access and edit the file.

g. Each group member will access the file from the URL. When the document opens, click **Edit Document**, and then click **Edit in Word**. Enter any login information (Windows Live ID) and edit the document to add event information. When a description is complete, insert a hard return so that the next description begins on a new page. Click **Save** on the Quick Access Toolbar to save the document back to SkyDrive.

h. Submit the completed document based on your instructor's directions.
**Beyond the Classroom**

You work with a local radio station that will award a dream vacation of one week in a resort area to a lucky listener. Select a destination and conduct some research to determine approximately how much it will cost your employer to make the vacation available. What travel arrangements are possible? What type of accommodations do you recommend? What activities are there to enjoy in the area, and what are some outstanding restaurants? Prepare a one-to-two page document, outlining what you think are the best selling points for the area and approximately how much the travel and hotel accommodations will cost the radio station. Because the document is for internal distribution in draft format, you do not need to be overly concerned with format. However, you should use skills from this chapter to properly identify the document (headers, footers, and watermarks) and to position it on the page. The document should be error-free. Modify document properties to include yourself as the author. Save the file as **w01b2Vacation_LastFirst** and submit based on your instructor’s directions.

---

Open **w01b3Policy** and save it as a Word 2013 file with the file name **w01b3Policy_LastFirst**. The document was started by an office assistant, but was not finished. You must complete the document, ensuring that it is error-free and attractive. The current header includes a page number at the top right. Remove the page number from the header and create a footer with a centred page number instead. Remove the word *copyright* where it appears in the document and replace it with the copyright symbol. Show nonprinting characters and remove any unnecessary or improperly placed paragraph marks. Insert hard returns where necessary to better space paragraphs. The hyphenated word *non-Association* should not be divided between lines, so use a nonbreaking hyphen, if necessary. Modify document properties to include yourself as the author and assign relevant keywords. Finally, use a watermark to indicate that the document is not in final form. Save the document as a Word 2013 file and as a separate Word 97-2003 document with the same file name. Submit both files based on your instructor’s directions.

---

After watching the video on time management and organization skills, think about how you could put into practice some of the tips suggested in the video. Specifically, consider how you might better manage your time with respect to completing class assignments, studying for quizzes and exams, and preparing for class. Then write an informal one-to-two page paper, saving it as **w01b4Time_LastFirst**, outlining changes you plan to make. You will use Word’s default line and paragraph spacing settings, but you should make sure the document also includes the following items:

- A left-aligned header with your name, and a centred footer including the page number.
- Top and bottom margins of 2.54 cm (1”) and left and right margins of 3.81 cm (1.5”).
- A *Draft* watermark of your choice.
- A smiley face symbol in an appropriate place within the document.
- Your name in the Document Properties Author area.
- No spelling or grammatical errors.
Capstone Exercise

Ethical conflicts occur all the time and result when one person or group benefits at the expense of another. Your Philosophy 101 instructor assigned a class project whereby students must consider the question of ethics and society. The result of your research includes a collection of questions every person should ask him- or herself. Your paper is nearly complete but needs a few modifications before you submit it.

Spelling, Margins, Watermarks, and Editing
You notice Word displays spelling and grammatical errors with coloured underlines, so you must correct those as soon as possible. Additionally, you want to adjust the margins and then insert a watermark that displays when you print so that you will remember that this is not the final version.

a. Open w01c1Ethics and save it as w01c1Ethics_LastFirst.
b. Run the Spelling & Grammar tool to correct all mis-spelled words and contextual errors. Identify and insert a synonym for the word whereas in the $50 Bill paragraph.
c. Change the margins to 0.75” (1.90 cm) on all sides.
d. Insert a diagonal watermark that displays Version 1. (Hint: Insert a Custom watermark, select Text watermark, and then type Version 1 in the text box.) Colour the watermark blue.
e. Remove the word new from the first body paragraph, beginning with Ethics refers to the principals or standards. You realize that the word principals is incorrectly used in the first sentence of the same paragraph. Change the word to principles. Proofread the document to find any spelling or word usage errors that Word missed.

Headers, Footers, and Features That Improve Readability
You will set up page numbering and will include a descriptive header. Because you are going to customize headers and footers precisely, you must use several of the custom settings available for headers and footers.

a. Insert a centred page number at the bottom of the report. Type your first name and last name in the header area. The header and footer should not display on the first page.
b. Insert a space and then a frownie face symbol after the word exam in the first sentence of the Honor Code section. You can find a frownie face symbol in the Wingdings font.
c. Insert a ™ symbol after Office 2013, in the Office CD paragraph.

Set Properties and Finalize Document
After improving the readability of the document, you remember that you have not yet saved it. Your professor still uses an older version of Word, so you save the document in a compatible format that will display easily.

a. Save the document.
b. Run the Compatibility Checker and Document Inspector, but do not take any suggested actions at this time.
c. Add Ethics, Responsibility, and Morals to the Keywords field in the document properties. Change the author to your first name and last name. Close the Document Panel.
d. Preview the document.
e. Save and close the file, and submit based on your instructor’s directions.